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1    Analyser program overview
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  1.1    Analyser basic features

1. View image series and grids

2. Make Analysis Protocols

3. Analyse images

4. View results

5. Convert images

Analyser basic features

1. View image series and grids

§ View image series and image grids captured with Cell-IQ Imagen. 

§ Open images into main window to create Protocols, i.e. to define parameters for analysis of the plate. 

§ Cell-IQ Analyser supports three image formats, bitmap (*.bmp),  jpeg (*.jpg) and tiff (*.tif).
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2. Make Analysis Protocols

§ Analysis protocol defines cell analysis for specific cell test. It includes analysis parameters, and can include cell
samples.

§ Batch process analysis of a well plate typically requires an analysis Protocol, which in some tools has to be
available before Batch process analysis is started. 

3. Analyse images

§ Automatic Cell image analysis is made in the Batch Process tool in the Cell-IQ Analyser.

§ The analysis tools in the Cell-IQ Analyser:

- Count and classify cells: Cell, neurite and area recognition tools that use user defined cell 

  sample library. How this is used in Batch Process:

a. Load the Protocol.

b. Select source images.

c. Define saving directory for the results.

d. Edit analysis settings (Optional).

e. Click Start.

- Measure fluorescence: Single and multichannel fluorescence cell intensity measurement.

- Measure scratch wound areas: Measure scratch wound areas and closure speed in horizontal 

  migration test. Uses threshold method.

- Measure area size: Measure cell population areas and growth speed. Uses threshold method.

- Measure tubules and branch points: Analyse angiogenesis images. 

- Track cell movements: Track cells and show cell movement trajectories and statistics.

4. View results

§ Cell-IQ Analyser results are normally presented in time curves that show changes in population over the entire
cell test duration. 

§ After Batch Process analysis finishes, the result curve window pops up. Analyser also saves the results into text
(*.txt) files that can be re-opened later.

§ Also result image series are typically saved during analysis, and they can later be for example converted into
videos.

5. Convert images

§ Batch Process tool includes also several image conversion tools:

- Stitch image grids into big images: Combine e.g. the nine image series of 3x3 image grid into one series
with large images.

- Export videos: Make video from image series.

- Combine/colour phase contrast and fluorescene images: Cell-IQ Imagen saves images in grey scale, and
different channels into separate folders. 

     This tool combines and colours them. 

- Image processing operations: Collection of image processing tools (including e.g  background correction
and image series judder removal). 
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  1.2    System requirements

System Requirements - Cell-IQ Analyser program

§ Microsoft Windows 7, Vista, XP or 8 with the latest service packs installed (32-bit or 64-bit editions) 

§ 1.5 GHz processor (2 GHz or higher recommended. Dual- or quad-core recommended if the computer is used
also for other purposes.) 

§ 2 GB of RAM (3 GB or higher recommended) 

§ 5 GB of free hard drive space (Minimum 350 GB hard drive recommended for result saving)

§ Minimum display resolution: 1024 x 768 (24-bit color) 

Multi-core computer support

By default the Cell-IQ Analyser program uses all the processor cores in the Cell Finder analysis (Cell counting and
recognition, Area finder and Neurite measurement). But user has option to select that only part of the available
processors will be used in analysis, see the image in below. If all cores are used in analysis, the computer can be
very slow with other processes.  
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  1.3    Change log

Analyser program versions change log:

--- AN4.4.0 ------------------------------------------------------

- Update: Phase contrast cell classification of fluorescence emitting cells.

- Update: Cell Tracking: Several positions can be selected simultaneously for result graphs.

- Update: Cell Tracking: Axis scales for Rose plots and centered trajectory graphs can be changed.

- Update: Cell Tracking: Option to set time point and distance limits for including cell to average results.

- Update: Cell Tracking: Centered trajectories: Possible to use different color for each cell.

- Update: Manual Cell Tracking tool: Backwards tracking added.

- Update: Manual Cell Tracking tool: Cell positions can be added from different channels to same time series.

- Update: Greyscale image support added (jpeg, tiff, bmp). All tools now accept them.

- Update: 16 bit tiff image reading support added. They are converted to 8 bit when read.

- Revamp: Previewing large image grid does not reserve much memory anymore.

- Revamp: Manual Cell Tracking tool: Confirmation prompt added for time point deletion.

- Revamp: Area size tool: The Growth result curve now starts from 0 instead setting the smallest value to 0.

- Revamp: Protocol making tool -windows cannot be opened anymore without selecting images for them.

- Revamp: Area Finder result graph background class legend now uses class name instead of “Background”.

--- AN4.3.0 ------------------------------------------------------

- Update: CellFinder image pre-processing brightness normalization level adjustment added.

- Update: CellFinder cell counting parameter slide bar selection added.

- Update: NeuriteRecognizer: Cell counting dots can be hid from result image.

- Update: Tracking tool: The data values from the Distance3D chart are saved to an xml file to result folder. 

- Update: TubuleFinder: Blur (advanced user-) parameter added to grey level threshold.

- Update: Image area -curve removed from results of all area measurement tools.

- Update: Movement tracking: Cell coordinates and time points added to the result xml file.

- Update: Launch Analyser -button from Imagen 4 opens the current Imagen cycle in Analyser.

- Update: Windows 8 support added.

- Update: New manual cell tracking tool. Also lineage tool added to this version.

- Revamp: Batch Process uses resolution also without cycle.dat if resolution selected from Main Window settings.

- Revamp: Judder fixer: Small performance improvements.

- Revamp: All slide plate image positions now fit to the well map when cycle.dat file read.

- Revamp: CellFinder: Result curve *.txt file saved already after analysis of one image series, not after all series.

- Revamp: BatchProcess: Result image saving made more secure and memory efficient.

- Revamp: Tracking tool: Backwards tracking does not change the cell positions user selects from last image.

--- AN4.2.0 ------------------------------------------------------

- Update: HW Analyser in Cell-IQ leaves one processor core entirely free for Imagen.

- Revamp: Plate map in main window: Image position can be selected with arrow key from the list view. 

--- AN4.1.0 ------------------------------------------------------

- New tool: Cell tracking tool. Track cells and show cell movement trajectories and rose chart etc. movement
statistics.

- New tool: Manual cell tracking tool. Shows  cell movement trajectories and rose chart etc. movement statistics.

- New feature: Use different cell counting parameters for different recognition classes in Cell Finder.
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- Update: Remaining analysis time estimate displayed during Batch Process.

- Update: Result curve graph default background changed from grey to white and x-axis shows hours.

--- AN4.0.0 ------------------------------------------------------

- Update: Well Plate map view kept visible in main window for preview image selection.

- Update: Well Plate map added to the Protocol making tools (Scratch wound tool etc.).

- Update: Manual measurement tools added to the Scratch wound and Area Threshold tools.

- Update: Result curves can be generated directly from the Protocol making tools (Scratch wound tool etc.).

- Update: Current result image can be saved to automatically generated Well folder from the Protocol making
tools (Scratch wound tool etc.).

- Update: Windows 7 style buttons etc. UI components instead of Win XP style.

- Update: Use micrometers instead of pixels in all the results that tell distance or area.

- Update: Batch process: Added option to select what cycles from the image series are analysed.

- Update: Batch process: Select multiple source image wells from plate map by drawing with mouse. 

- Update: Grid stitching: Stitching combines correct time points, even if some image positions have less time
points than others.

- Update: Grid stitching: Image resizing integrated to the stitching tool.

- Update: Grid stitching: Background correction integrated to the stitching tool.

- Update: Grid stitching: Match image edge brightness between the grid images -feature added.

- Update: Grid stitching: Brightness adjustment bar added to the Batch process stitching tool.

- Update: Grid stitching: Stitched image preview button added to the stitching tool.

- Update: FL measurement and Combining/colouring: Do not use FL channel in combined image if it was disabled
from imaging in that time point (but enabled on some other time points). Earlier the closest FL time point was
taken in all cases.

- Update: Result curve graph: XY axes and legend font editing added.

- Update: Result curve graph: Show LD50% point. Also show point of N% of total cell count.

- Update: Result curve graph: Smoothen curves by polynomial curve fitting.

- Update: Result Curve grid: Show combined curve for well. Show Y axis scale. Use curve smoothening.

- Update: Scratch wound tool: New parameter added: Pre-filtering level for the threshold source.

- Update: Cell Finder: Neurite Cell diameter parameter (B) will not anymore remove neurites from areas of cells
recognized to a disabled recognition class.

- Update: Analyser main window is hidden when Batch Process is started, and shown when it finishes.

- Update: Image brightening value from Main window is applied also in the cell image in the Threshold tools.

- Update: FL result curve graph sheet names changed. E.g. Area count -> Cell count.

- Update: FL tool: When cells selected manually in FL tool, they are remembered in Batch Process.

- Update: Open one image series -button removed from the main Window. Its functionality added to Open grids -
button. 

- Revamp: Do not allow result saving to the source image folder.

- Revamp: Confirm that data lost is ok if user changes e.g. from Cell finder to Area Finder.

--- AN3.3.0 ------------------------------------------------------

- New Tool: Manual Cell Lineage analysis. 

- Update: FL tool: Let user select cells from any image in series when manual cell selection mode selected.

- Update: Video export: Show scalebar in the video.

- Update: Video export: Add more than one free-word text fields to video.

- Update: Image file name for every time point added to the exported XML result files.

--- AN3.2.0 ------------------------------------------------------
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- New Tool: Automatic Cell Lineage analysis. 

- Update: Protocol making guide merged to the Analyser help manual.

--- AN3.1.0 ------------------------------------------------------

- New feature: Wells or well groups can be combined and compared to each others in the result curve window.

- New feature: Standard deviation can be shown for combined curves in the result curve window.

- New feature: New curve graph settings window, with several graph modification options (for titles and axes etc). 

- Update: FL tool: Tiff saving added to Batch process. Earlier it saved Tiff source image in bitmap format.

--- AN3.0.1 ------------------------------------------------------

- Update: The user interfaces of the Scratch wound finder and the other threshold finders updated with some new
visualization and tools presented in the new FL tool: E.g. the batch process quick start buttons added. 

- Update: FL measurement: Single cells now identified with colours and IDs in the scattergram result curve, when
the manual cell selection method used. This way the same cell can be found from curve and from result image.

- Update: Neurite Classifier made faster: Only half of the neurite pixels are classified, and the result is copied to
the adjacent pixels.

--- AN3.0.0 ------------------------------------------------------

- New tool: The multilabel Fluorescence intensity measurement.

- Update: The image colouring and combining tool replaced with the new tool. Now also possible to save the
colouring and combining parameters to a protocol.

- Update: Cell tracking added to the Batch Process.

- Update: Scratch wound tool: Single cell removal using cell area size criteria added. Added feature for removal all
the gaps that are not connected to the big centre wound, or keep also the gaps that has area close enough to the
biggest gap. Remove cells inside the biggest gap. 

- Update: Judder fixer: Colour image support and tif saving added.

- Update: Cell count etc. results are displayed in the Cell Finder protocol test image.

- Update: Images can be opened to the Analyser main window using *.dat file.

- Update: Tiff saving added to the Image Processing operations in Batch Process

- Update: *.dat file version 3.0 support added. (Imagen IM2.8.0 uses this.)

- Update: Grids can be stitched even if image folders for the grid corner positions do not exist.

--- Version AN2.3.1 ------------------------------------------------------

- Update: Result curve window: The class sum curve option added in addition to the class average curve.

- Update: Line width etc. graph options can be changed from curve window for all Analysis methods.

- Update: All the result curves now start from 0 time point in the result graph.

--- Version AN2.3.0 ------------------------------------------------------

- New feature in Tubule finder: Tubule recognition by classification added.

- New feature in Tubule finder: Manual measurement tools added.

- Update: Tubule finder: Tubule width, BranchP width and color in result images can be changed and saved to
Protocol

- Update: Different wells have different line types in result curve graph

- Update: Grey level threshold added to tubule finder and Area Thr finder.

--- Version AN2.2.2 ------------------------------------------------------

- Cell coordinate export changed to work with Image-Pro Cell-IQ plugin. Also Image name saved in full length to
the CellCountCurve.txt file.

- Empty CellCountCurve.txt files and their folders are not created anymore in manual export.
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--- Version AN2.2.0 ------------------------------------------------------

- New feature: Interactive parameter selection tool Tubule finder

- New feature: Mouse wheel operated zoom added

- New tool: Image series XY Judder fixer added to Batch process Image processing tool

--- Version AN2.1.0 ------------------------------------------------------

- New feature: Large cell analysis. User can define two areas, a circle and surrounding disk for cell recognition. 

- New tool: Scratch wound measurement using threshold methods. Also in Batch process. 

- New tool: Area size measurement using threshold methods. Also in Batch process. 

--- Version AN2.0.1 ---------------------------------------------------

- Scale bar added to preview images. Units are in pixels in default, or user can write resolution and select display
in micrometers

- Several samples can be moved as a batch from one class to another

- Help file changed to pdf format

--- Version AN2.0.0 ---------------------------------------------------

- New user interface. The controls were removed from the right hand side of the main window

- Improvements to Protocol making:

  - New window made for segmentation parameter selection

  - Graphical tools added to the segmentation parameter selection

  - Automatic cample selection: Segmentation takes the found cells to sample library

  - Classifier building moved to own thread, and hence program does not jam while building

- Updates to cell tracking: User can select if the tracking vectors are drawn to cell images or not.

- Angiogenesis analysis v1 added to batch process
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  1.4    Analyser installation

Software is supplied in an installer program exe file. Start the installer and follow the instructions in the dialogs.

After installation is complete and the program is started the first time, it asks for the activation code. Please send
the site code and MID code to the CM Technologies, so we will provide the Activation code.
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  1.5    License transfer

The program can be moved to another computer by following the instructions below. Note that the program must
be first deactivated from the old computer, and the deactivation must be proved by supplying CM Technologies
(CMT) the removal code, before the new activation code is supplied for the new computer!

Hold the Ctrl- or Shift-key down and Start the program from the Cell-IQ Analyser program icon. The program
activation dialog appears. Follow the instructions given in the images below.
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After this you can use the Analyser installer exe for installing the Analyser for the new computer. Please ask
guidance from CMT for which installer version should be used. Please send the removal code (received in the
deactivation) to CMT together with the new Site code and MID codes the Analyser gives in the first start after the
installation, and CMT will then send you the new activation code.
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  1.6    Analyser main window



View image series and grids 
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2    View image series and grids

§ Open images for preview: It is recommended to open images by selecting the *.dat file from the Plate folder.
This way program will know the image grid sizes, well plate format and image resolution.

§ If several image folders were selected, the plate map is displayed on the right side of the main window. If
images were selected with *.dat file, also the graphical one well view (bottom right) is displayed. If program
automatically found the Plate Fluorescence image folders, it shows the drop down channel selection box in the
top bar.

§ Image viewing tools
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Note: Use mouse wheel to zoom images without resizing the image frame. This way you can zoom also when image grid
is open, without changing the image positions.

§ The speed of the image slide show and the scale bar settings can be changed from "Settings à Image viewer".

Saving images
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Movie maker 
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3    Movie maker

Video settings
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Captions and logos
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4    Image analysis steps

The image analysis is made with the following steps:

1. View images and evaluate which Analysis method(s) give required results.

- See the list of analysis methods from the Analyser basic features chapter.

2. Make and save Analysis Protocol that defines the analysis task and parameters.

- See how Cell recognition Protocol and the other Protocol types are made from 

  the corresponding chapters.

3. Run analysis in Batch Process for the entire plate or selection of wells.

- See from the the Batch process chapter how the plate is analysed with the different tools.

4. View results in Analyser and export them to Excel if necessary. Videos can also be made from result images.

- See from the Analysis results chapter how the results are viewed in the curve graph window.

- See from the Batch process chapter how the result images can be post processed 

  and e.g. exported to videos.
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5    Making cell recognition Protocol

The Cell Recognition protocol is needed when cells are
analysed in Batch Process with the Cell counting and
recognition tool. The tool counts cells and classifies them
into the user defined classes. The analysis protocol can
define cell size, population density, neurites and areas in a
specific cell test.

Segmentation and classification

Creating an analysis protocol has two major phases: 

(1) Segmentation parameter selection and 

(2) sample library making. 

Correspondingly, in the analysis run, the system first segments the images, in other words finds the interesting
objects (= cells, neurite or area) in the image. Next these objects are recognized into user defined classes using
the classifier that has been created based on information in the sample library. 

Overview on Protocol making process

The process of creating an analysis protocol starts with defining the protocol type e.g. cell classifier + neurite
finder. The following steps are setting the segmentation parameters, collecting a sample library and setting the
classification parameter. The classifier is then ready to be built. Then test run is performed with the completed
analysis protocol to evaluate its performance. If the result is not satisfactory, the segmentation parameters can be
adjusted, the sample library can be reviewed and the classification parameter can be adjusted. This cycle is
repeated until the analysis results are correct.
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  5.1    Protocol types

§ Cell Counter
§ Cell Analyser
§ Neurite Finder (with cell counter)
§ Cell Analyser + Neurite Finder
§ Neurite Recognizer
§ Area Counter
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  5.1.1    Cell counter

          



30Cell-IQ Analyser User Manual

CM Technologies 9.1.2015

Version MA4.4.0.0

  5.1.2    Cell Analyser
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  5.1.3    Neurite finder (with cell counter
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  5.1.4    Cell Analyser + Neurite finder
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  5.1.5    Neurite recognizer

 

*Note: Assign just one class for the neurites and one or more for all objects that are excluded from the
measurement, also including cells. Two different types of neurites can be classified with a combination of two
separate neurite recognizer protocols.
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  5.1.6    Area finder
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  5.2    Protocol making steps
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Now the cell counting part of the protocol is ready. Save the protocol from the Analyser main window: File -> Save
Analysis Protocol.

Sample library making

Next you need to make the sample library, as instructed in the following topic:Sample library -> Creating sample
file. It is recommended to add minimum 100 samples from the whole experiment to each class for analysis to be
accurate. See more detailed explanation about the sample selection in the document Protocol guide.

Build and test the protocol

After the sample library has been created, the classifier has to be built (see the image in below) and tested in case
it is needed to modify the sample library for even better analysis accuracy. When Protocol building finishes,
program prompts to save it to file.
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The protocol is now finished and ready to be used in the Batch Process tool for running an analysis. Save the
protocol from the Analyser main window: File -> Save Analysis Protocol, if it was not yet saved.
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  5.3    Image pre-processing

Image brightness level normalization

By default the Image brightness is

normalized to fixed level (151) before any

analysis is started, so that the same

Analysis Protocol works accurately even if

the source image brightness changes.

- The same brightness parameter is applied both before the cell counting and before the cell recognition.

- First adjust the brightness parameter and only after then add the samples.

- The cell sample brightness is changed only when it is added to the sample library, hence the source image

brightness must stay in the same value what was selected when samples were added.

- The cell sample brightness must match to the image pre-processing brightness, for accurate cell recognition.

-> The brightness parameter is disabled in the user interface after you have added the first cell sample.

The image brightness parameter can be selected from two places, but the parameter that changes is anyway the
same regardless from where it is changed:



39Cell-IQ Analyser User Manual

CM Technologies 9.1.2015

Version MA4.4.0.0



40Cell-IQ Analyser User Manual

CM Technologies 9.1.2015

Version MA4.4.0.0

  5.4    Sample Library

Sample library guide

§ Defining classes

§ Creating a sample library file (*.ims or *.cts)

§ Viewing the samples in a sample library file

§ Editing sample library file by moving and deleting samples, renaming and merging classes. 

Sample library is the tool for designing analysis protocols for specific cell tests. Also, if an analysis protocol is
requested from CM Technologies, a sample library will need to be attached corresponding for the analysis needs.
A sample library is a collection of samples of cell, neurite and area types selected by the user. The sample library
is essential for the creator of the analysis protocol. Samples are selected from cell images in Analyser and saved
into a *.cts sample file. Create an analysis protocol by setting the segmentation parameters, the classification
parameter and by building the classifier. The detailed instructions are in the Protocol Guide. Contact CM
Technologies to request for an analysis protocol made by a protocol specialist.

Note: If a Sample library is done and saved into a *.ims protocol file instead, the saved file has all the same
information as in the *.cts file, and additionally the cell counting parameters. And if the protocol had been built
prior to saving, also the *_classif.txt classifier file is automatically saved.

Number of samples

The Sample library in a completed Protocol has normally a minimum of 100 samples in each class, and there is no
upper limit to how many samples can be included; the higher number normally results in better accuracy. If the
protocol is ordered from CM Technologies, normally 20 samples in a class is sufficient. But it is important to clearly
demonstrate the difference between the classes. Each class can have a different number of samples.  

Cell size and position

Recognition is done from a single cell, not from the position of cell in a cell colony. One may be tempted to define
cells into the classes based on their position in a colony (near center / near edge), but the cells must look different
inside the sample window. Cells that are larger than the sample window can still be recognized if there are visible
differences to other classes inside the sample window.

Sample window

The recognition of cells is based on features extracted from the sample image. Those features describe the
surface structure and outer shape of the cells. Features must be seen inside the sample image. But since the cells
are not counted based on the sample window, the entire cell area does not need to fit inside the sample window.
The size of the sample window can be changed from the Recognition area -settings.

The classifier

The classification is defined by the classifier. For building the classifier you need to have a sample library that
defines the classes in the protocol. You also need to set up the classification parameter and build the classifier.

Summary
? Define only classes with clear difference between them that is visible inside the sample square.

? You can combine uninteresting objects into one class. Different looking objects can be assigned to the same
class.

? Objects that look too identical can't be in different classes. The recognition accuracy suffers in both of those
classes.

? Classification is not based on cell movement or cell history.
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  5.4.1    Defining classes

About creating classes

? Browse the cell images throughout the cell test data and examine the morphology of different phases.

? Create two or more classes for the cell types and phases you want to analyse. Remember to assign all
objects present in the images to one of these classes including debris, garbage or other particles. If there
are a lot of uninteresting objects in respect of the cell count and recognition, you can make one class for all
those items. For example, if there are garbage particles, unwanted cell type or multiform trash on the
background, they can all be defined into a class "other", see image below. Everything is counted anyway in
the segmentation phase.

? Defining too many classes e.g. more than six, the classes might not have clear enough differences
between them to be distinguished accurately.

? Cells are recognized from one image view, not based on cell movement or cell history.

? A clear difference in features must be seen between all the sample images of two different classes.

? Assign each sample into the right class based on the currently viewed image, not based on the images
before or after.
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  5.4.2    Creating sample file

§ Click Pick samples button (see image below) or go to Tools menu to open the Pick samples window. 

§ Add cell types/phases: Select Cell type or Cell phase first and click Add new. Each cell phase will be a class
in the protocol where as each Cell Type is meant to group cell phases clearly and doesn't affect the
classification.

§ Delete cell types/phases: Click the type/phase once and then click Delete. 

§ Rename the cell types and phases: Click the cell type/phase name. Then click the active name a second
time. Edit the name in the active box.

§ Note that defining several phases e.g. more than six, the classes might not have clear enough differences
between them to be distinguished accurately. 
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Teaching

Select the Add samples sheet to collect samples to the classes.

§ If there are no samples added yet, program offers to change the cell sample window size. Default window size
is good in most situations, and you can click No to keep it. You can change the window size at any time later
(with some constraints) also by clicking the Size button. 

Note: The window size for the cell sample images in the saved protocol file depends on the selected sample
window size. If the selected size is small, the saved size is small, and when you increase the window size in
the program later, the sample image size will be increased artificially, and the analysis accuracy may
decrease somewhat. The program never decreases the saved sample size, so if you first increase the size,
add samples, and then decrease the size, the bigger save size is used for all samples, even if displayed size
is smaller.

§ Click the name of a cell phase to add samples. The active cell phase becomes highlighted by a dashed
rectangle.

§ Search samples in the image and place the square cursor on a sample candidate. Make sure that the cell is in
the center of the square in the sample preview and click Add sample.The number after the cell phase
increases by one. 

§ Repeat this procedure to add all samples. The ideal amount of sample is highly case specific but usually bit
over 100 samples in each cell phase is sufficient for  good recognition and 10 - 20 samples for demonstrating
for protocol maker what classes will be needed for the protocol. Select samples throughout the cell test.
Browse through images to obtain a comprehensive sample collection. 

§ Save the sample library into protocol file (*.ims) from Analyser main window by clicking Save. Before you exit
the program remember to double check that you have saved the sample library file as *.ims. The protocol will
have to be completed by building the classifier on the Building Protocol sheet.
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Note: When you make an analysis protocol, you can add cell samples automatically after you have selected the
cell counting parameters.
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Merging classes

Any two classes in the sample file can be merged into one. If two classes turn out to be too similar, merging them
into one will save the samples unlike when deleting a class. The operation can not be reversed.
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  5.4.3    Viewing sample file

§ Always review the collected samples before saving and closing the sample file. Remove any inappropriate
samples and move misplaced samples to the right class. See next topic Editing sample file.

§ Open the sample file into Analyser and select Tools -> Sample library or click Sample library button on the
Add samples -sheet of Pick samples -window.

§ The samples can be saved only from the Analyser main window by clicking Save. However, you can save a
jpeg snapshot of the current Cell sample window. Select Save images view from the File menu. The sample
information is not included in the jpeg image but in an ims file. 
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  5.4.4    Editing sample file

To have a good sample library, go through your sample selections carefully and make necessary changes. Some
samples may be placed into the wrong class. Move misplaced samples into the correct class. Delete any incorrect
samples, such as seen in the example of a poor sample library. 

Example: good sample library
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Example: Poor sample library
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  5.5    Cell counting parameters

Note: The instructions in the following chapters give suggestions and usable ranges for the cell counting
parameters, but the user can freely try any such parameters that exceed the given limits, though it is unlikely that
they will give the best result.

SEGMENTATION PARAMETER WINDOW
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  5.5.1    Cell counting

 

(D) SEGMENTATION GRADIENT THRESHOLD

Segmentation gradient threshold is a threshold value in the traditional meaning – a small value results more
correct segmentations as it means the system is more sensitive to the intensity changes in the image. At the
same time also the number of faulty segmentations increases because some intensity changes are not cells.
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(E) CELL DISTANCE

The cell distance defines the distance between two neighboring cells – a small value potentially results more
cells to be segmented.

 

(F) MAXIMUM CELL DIAMETER

The maximum cell diameter defines the size of the biggest cells in the population.
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(G) CELL SYMMETRY PARAMETER

With the cell symmetry parameter the user can emphasize the importance of cell symmetry in the cell
segmentation. In this terminology an exactly round cell is the most symmetrical target.

The system always first identifies the cell centers in the image. Sometimes small and dim cells coexist with big
and bright cells. In such case the system can find cells in the background right next to the bright cells even
though there's really nothing.

However, the symmetry parameter implies that there are cell edges found in every direction (360º) around the
cell center position.

 

SEGMENTATION PROTOCOL PERFORMANCE

Objects and patterns in the images that affect the accuracy of the segmentation and can cause faulty or deficient
segmentation:

? Garbage and debris on the background

? Image is out of focus or shaken
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  5.5.2    Neurite segmentation

 

SETTING NEURITE PARAMETERS
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1. Neurite threshold value guidelines

2. Cell diameter for neurites guidelines

 

EXAMPLE: TWO NEURITE SEGMENTATION CASES
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  5.5.3    Class specific counting parameters

Different counting parameters can be selected to find small cells and different parameters for the large cells.

§ Often one counting parameter set is enough for all cells, but sometimes it can be difficult to find one set of counting
parameters that work for all the cells in image, image series or well in the plate.

§ One set of counting parameters can be selected to find small cells and different counting parameters for the large
cells. The same sample library is always used both for small and large cells. 

§ The number of the counting parameter sets is not limited to two, or to any other number. Different counting
parameters can be selected for every recognition classes if needed. 

§ Neurite segmentation can be enabled in one or more counting parameters sets. Program will take the found
neurites from them all to the results.

Steps:

1. Make CellFinder protocol the same way as with only one counting parameter set. Optimize the counting
parameters for the first cell type. If counting is now accurate for all cells in image, and for all recognition classes,
you can ignore the next steps.

2. Add new counting parameter set from the “+” -button in the counting parameter window. Optimize these
parameters for the other cell type.

3. Go to the Class styles -window, and select the counting parameter set 2 for the recognition classes that work best
with these counting parameters.



59Cell-IQ Analyser User Manual

CM Technologies 9.1.2015

Version MA4.4.0.0

  5.5.4    Tips

GETTING STARTED

Even though the images can never be perfectly segmented with any device the result can be optimized by
improving the parameters according to the cell test qualities.

It is recommended to collect a set of images which  represent the cell test as comprehensively as possible. It
might be a few images from the start, the middle and the end of the cell test and depending on the well plate
size. Select positions from different conditions.

 

ADJUSTING PARAMETERS

Once this set of images is selected,the analysis can be run with the default parameters. If the result is not
correct, adjust one parameter at a time in small steps and run the analysis through the test set. Evaluate the
result images by eye. Repeat the iteration until the result is acceptable.

Segmentation gradient threshold

? If the cells have low contrast try decreasing this parameter in small steps from the default value

? If the cells have high contrast try increasing this parameter in small steps from the default value

Cell distance

? If the population is dense try decreasing this parameter in small steps from the default value

? If the population is sparse try increasing this parameter in small steps from the default value

Maximum cell diameter

? If there are relatively small cells try decreasing this parameter in small steps from the default value

? If there are relatively big cells try increasing this parameter in small steps from the default value

Cell symmetry

? If the cells are symmetrical and there are faulty segmentations on the background near cells, try increasing
this parameter in small steps from the default value. You might have to increase the segmentation gradient
threshold a step too.

 

ACTION TO TAKE IN CASE...

Cell segmentation
? There are too many spots -> increase the segmentation threshold value

? All the cells are not counted -> decrease the segmentation threshold value

? Individual cells have several spots -> increase cell distance and/or the maximum cell diameter

? There are a lot of spots on the background near cell edges -> increase the cell symmetry parameter

? There are some spots on the background and no cell edges near -> increase the segmentation
threshold value until they disappear.

Neurite segmentation
? There are neurites found inside cells -> increase the neurite threshold value and/or cell diameter for

neurites
? All the neurites are not found -> decrease the neurite threshold value

? There is garbage or debris in the background which are counted as neurites -> increase the neurite
threshold value

DETERMINING THE MAXIMUM CELL DIAMETER

Slide the cursor over the biggest cells on the image and see the pixel dimensions on the bottom. This gives you
an idea of the maximum cell diameter. However, if the majority of the cells are smaller, then decreasing the MCD
moderately to ensures correct segmentation.  

 

PARAMETER INTERRELATION

Sometimes changing one parameter might require to change an other one. For example,  increasing the
symmetry parameter can require decreasing the segmentation gradient threshold, and increasing the maximum
cell diameter might require increasing the segmentation gradient threshold. There's no universal rule as this is
case dependent and can be detected only by testing. For instance when changing the maximum cell diameter the
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threshold value can be adjusted in case of it still improves the analysis result.

WHAT IF THERE ISN’T A PARAMETER COMBINATION THAT GIVES GOOD ENOUGH CELL
COUNTING ACCURACY?

In many cases the cell counting accuracy can be improved significantly using the cell recognition feature (that is
explained later in this guide):
§ If there are spots in the background between the cells, and it is not possible to delete them, the

following can be performed: Make a 'Background' -class and teach the false background spots to that
class. Use the tools in the 'Edit class styles' -window in the Analyser to make the background spots
invisible in the result images and remove them from the result curves at the same time.

§ If you have spots in the edges of the cells, in the membrane, you can for example teach them also to the
'Background' -class.
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  5.5.5    Examples

The selected set of cell counting parameters often apply for the same cell type if the objective magnification (4X,
10X, 20X or 40X) 

is kept constant in the imaging system. If it is changed, the new parameters need to be found.

 

EXAMPLE 1: RAT NEURAL CELLS, 10X OBJECTIVE

The selected parameters
are:

(A) Find neurites                  
Enabled

(B) Neurite threshold            
      55

(C) Cell diameter (for
neurites)        29

(D) Segment grad. thresh.    
  37

(E) Cell distance                23
pixels

(F) Max cell distance            
  31 pixels

(G) Cell symmetry               
75

Image from Institute of Biotechnology, University of Helsinki

EXAMPLE 2: FLUORESCENCE CELLS, 10X OBJECTIVE

The fluorescence images are counted with the same tools as phase contrast images, and the parameter
selection follows the same principles.

Below is a step by stem case example for the parameter selection for fluorescence image. We start with the
parameters (D) Segment grad. thresh. 35, (E) Cell distance 27 pixels, (F) Max cell distance 37 pixels, (G) Cell
symmetry 0.
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The selected parameters are:

(D) Segment grad. thresh.        33

(E) Cell distance                33 pixels

(F) Max cell distance                39 pixels

(G) Cell symmetry                35

EXAMPLE 3: HK2 CELLS, 10X OBJECTIVE, JAI CAMERA

The selected parameters are:

(D) Segment grad. thresh.     
 35

(E) Cell distance                27
pixels

(F) Max cell distance             
 37 pixels

(G) Cell symmetry                0

Image from Cell Research Center, University of Tampere
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  5.6    Sample teaching tips

Cell counting and recognition

A good analysis accuracy is usually achieved by
§ Clear representation of classes in the sample library

§ Picking samples throughout the cell test

§ Picking samples by clicking in the geometric cell center supposing the cell edges are visible.

However, some conditions may require picking samples of areas where single cells are not distinguishable, e.g.
a cell colony. In that case a separate colony class should be created and taught to avoid any error in other
classes. The cell count for that colony class is not accurate, but the other classes will be more accurate.

CELL COLONY

DEBRIS AND BACKGROUND

DIVIDING CELLS
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Neurite recognizer

One class for neurites is to be included into the measurement and everything else in other class(es), also cells.
Click neurites so that they go through the center point of the sample window. You can for example include thick
neurites into the measurement by selecting thick neurite samples into the “All neurites” class and thin neurite
samples into another.

Area finder

When picking samples of the different areas, make sure to also pick samples of the borders of each area type,
just few pixels away from their borders. It doesn't matter if almost half of the sample is background or other area
type, as long as in the center of the sample window is in the right class. Always teach the background.
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  5.7    Auto-generate cell samples

After satisfactory cell counting parameters have been selected, the cell samples for sample library can be
generated in a more automatic way to speed up the process of building the sample library: 

§ After you have clicked "Test one image" button, you can use the found cell coordinates to generate cell samples
automatically, by clicking "Tools -> Auto-generate samples".

§ Move auto-generated samples to the user defined classes using the sample library window.
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  5.8    Building Protocol

 

BUILD PROTOCOL

The protocol has to be completed by converting the Sample library into classifier, with the Build Protocol button,
as explained in the image below.

THE CLASSIFICATION PARAMETER (=RECOGNITION COMPLEXITY) GUIDELINES

§ Small total cell sample number (e.g. 300 samples) -> g is small (e.g. 0.7)

§ Large total cell sample number (e.g. 600 samples) -> g is big (e.g. 1.35)
§ Too small value results inaccurate analysis, since a large part of the cell samples are deleted in learning

process regarded as unnecessary.
§ Too big value results inaccurate analysis as well since the single cell samples have smaller visibility.
§ Usable range: 0.7 - 1.4
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  5.9    Testing protocol performance

 

REVIEW, ADD OR REMOVE SAMPLES

- Examine the misclassified cells in the segmented result images. If you can see a pattern there you can
teach certain type of appearance by adding 10-15 such samples and try again.

- Make sure every class is clearly recognizable by eye. Also make sure that all samples are selected in the
center of the cell. If not, remove such samples.

- If the color coded spots are not at all in the center of the cells, try fixing the segmentation parameters.

- If the spots are in a right place but the class is wrong in many cases, try teaching the more
comprehensively by adding samples to all classes with poor accuracy.

 

DELETE, MERGE OR REORGANIZE CLASSES

- If two classes x and y are both perfectly round and it is impossible to distinguish these two morphologies at
some stage, merge them into one round class.

- The dividing cells can sometimes look very similar to dead cells, round and non-adherent. However, the
amount of cell
division can be obtained directly by the derivate of the cell count curve. Therefore, teaching the dividing
class might not be necessary as not all divisions can be captured due to the cycle time being greater than
mitosis time. If creating a class for dividing cells is relevant, only assign samples to the dead class that are
clearly granular, and the perfectly smooth ones into the dividing class.

- Sometimes distinguishing between early differentiation and late differentiation is not accurate and those
classes can be merged into one differentiating class.

- Multinuclear cells and cells with single nucleus might not look different enough in the sample window.
Distinguishing between the two might not be accurate enough so they can be merged.

LIMIT TIME LINE & MAKE MULTIPLE PROTOCOLS

If the population changes so dramatically that towards the end there are completely different cell morphologies
and cell sizes and they get confused with some cells in the beginning, you could divide the analysis in to different
phases and create a protocol for each phase to obtain more accurate analysis.
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  5.10    About analysis performance

CELL POPULATION

- The confluency of the population is best kept at low to medium for the best results. If the cells in the
population cannot be distinguished by eye, it is likely that the cell counting accuracy will decrease. If the
images contain areas of high confluency, it is best to include them to avoid false classification of other
classes.

- If there is a cluster of dead cells or debris together with live cells, the clustered population often cannot be
counted. However this rarely interferes with the healthy population, as long as the clusters are included into
a background class. The same principle applies for any large objects in the field of view, they can be
added to the background and thus do not affect the counting of the target cells

 

- If there's a lot of dead cells tangled together over the healthy population, the dead cells can't be
distinguished and counted. However, the stable cells can usually be counted accurately. In this case
include samples of the dead cell mass also into its own class or combine it with other such as the dead cell
class etc. If for some reason there is a big piece of trash in the image you can include samples of that into
e.g. a garbage class to avoid its interference with the cell count.

 

- If there's a lot of garbage in wells, define a garbage class to sample library to avoid the garbage being
faultily counted as cells. Small particles can interfere the neurite measurement in Neurite finder tool, but by
using the Neurite Recognizer protocol you can teach the system to recognize and discard the small
garbage.

- Small particles can interfere also the neurite measurement in Neurite finder tool, but by using the Neurite
Recognizer protocol the system can be taught to recognize and discard the debris and scratches on the
plastic.
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- Two-layered cell population: Cells are counted and recognized from a single image, so if the two cells are
on top of each other, at least one of them is not counted and the recognition accuracy can decrease.

 
- Cell colonies, tissue samples and embryos: Cell-IQ can take images that show features in the selected

Z-range from a thick target. This slice can be analysed using the Area Analysis method, where the system
divides the target into the different areas based on the texture. In this case it analyses more the structure,
rather than the individual cells.

- Long, low contrast cells: The cell analyser finds the cell centers (segmentation) in analysis before they are
recognized, and the segmentation is based on the features inside the cells and the cell edges. Hence the
foil-like cell types that have a body that is very flat and long (tens of micrometers) and has no clear edges,
may not be segmented and recognized accurately.

 

IMAGE QUALITY

- Poor image quality due to e.g. images being out of focus can decrease the accuracy of the analysis.
Images can be out of focus because:
- Cells are not adherent.

- There are particles floating in the medium.

- Imagen parameters are not optimal for the cell population type, or the cell test is not started according
to the given guidelines.
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- Poor image quality due to images being taken too close to the well edge, where the phase contrast
illumination field is not optimal, can decrease the accuracy of the analysis.

 

 

CLASS DEFINITIONS

- If the cells look similar even if they are biologically in different phases or cell types the system might not be
able to distinguish them.

- If the cells in two classes look similar only inside the cell sample window, even if they move differently or
their processes have different number of branches, the system might not be able to distinguish them.

- Cells actively change shape and look similar from time to time, even if they are different phases and look
different most of the time. In this case it is possible to define an additional class for the uncertain cell
shape. This way it is easier to quantify the analysis error.

HARDWARE CHANGES

- If the image resolution changes due to changing the objective or the camera, a new analysis protocol must
be created for the new resolution.



Making the other Protocol types 

6
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6    Making the other Protocol types

The following analysis protocols are made with similar parameter selection interface:

§ Fluorescence intensity measurement

§ Fluorescence image combining and colouring

§ Scratch wound measurement

§ Area size measurement

§ Tubule and branch point measurement

Optionally the result curves can be generated directly from the protocol making tools, without the Batch Process:

§ Each measurement that is made, with automatic or manual tools, is automatically saved to memory for the plate
for that image positions and time point.
§ The measurements of the plate can be displayed in the Curve graph with the Show results -button. 
§ The measurements of the plate can be saved to result text files with the Save results -button. 
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  6.1    Fluorescence intensity measurement

Analyse images from single and multichannel fluorescence cell tests
with the Fluorescence intensity measurement tool. 

§ Measurement is based on thresholds and selected parameters,
and no cell sample image teaching is necessarily needed, but it can
be utilized, as later is shown. 

§ The fluorescence cell count, area and intensity are measured. 

§ The tool can utilize both the phase contrast and fluorescence
images at the same time. 

Fluorescence intensity measurement procedure

There are two optional ways to do the analysis:

Option 1: 

Step 1: Select the analysis parameters and save them to a Protocol file. 

Step 2: Go to Batch process, open the Protocol from file when asked, and fine tune the parameters if
needed.

Option 2: Go directly to Batch process, and select the analysis parameters on the go. No protocol file is needed.

Making a fluorescence analysis Protocol

§ Open images to the analyser main window using the *.dat file, and open the Fluorescence intensity
measurement tool from "Tools -> Fluorescence - intensity measurement".

§ The preview image that was in the main window is automatically opened to the Fluorescence measurement
tool preview window.

§ Select the measurement parameters step by step. The intermediate results image is always displayed on the
right hand side of the window.

§ You can change the preview image at any time.
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· When the images were opened using *.dat file, images from all the channels were loaded at once also to the
Fluorescence tool. You can preview any channel at any time by clicking the radio buttons above the image. You
can also preview all the channels at the same time as a combined image, with or without the phase contrast
channel. 

o The result parameter selection sheet on the left side of the image shows the parameters of the currently
displayed channel. Each channel has its own set of parameters.

   Hint: If you want to remove some of the fluorescence channels from the combined image, disable it from the
"Include to protocol" selections. 

· Image brightness, contrast and gamma can be adjusted, so that it is later easier to select the threshold etc.
parameters, and that the result images will look better. 

o These parameters will be set for each channel separately. Each channel can be set up individually through
steps 1-9 or completing each step for all channels.



77Cell-IQ Analyser User Manual

CM Technologies 9.1.2015

Version MA4.4.0.0

· Make background correction. Typically the image background gradient is removed, resulting background with
an intensity value of 0. This will make it easier to select the threshold value later.

· Subtract one channel from an other. The signal from a channel sometimes bleeds through to another channel,
especially from the lower wavelength emission channel to the higher wavelength channel. In the image below
the 14% of the pixel intensities of the GFP channel (FL1) is subtracted from the pixels intensities of the Red
channel (FL2). The calculation would be: Red_result = Red_original - 0.14 x GFP_original.
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· Apply intensity threshold. In the resulting binary image the objects of interest are separated from the
background and hence can later be measured for intensity, area and count. Select the upper and lower
threshold limits - the intensity values between the limit values are segmented as the objects of interest.

· Fill closed holes from the segmented areas and remove objects that have small area size.

o The number of fluorescent objects is counted from the image in the later steps, and it is often more illustrative
to get the count of only the large size objects.
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· Split areas: Use shape analysis methods to count two connected areas as two separate objects. 

o This step also automatically counts all the non-connected objects, using the threshold result image as a
source image. The area color shows which areas are connected and which are non-connected and hence
counted as several objects.
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· Select how the cells are counted. There are the three basic options available: (1) Count from fluorescence
image, (2) count from phase contrast image with Cell Finder protocol, (3) or user can manually select the cells
from the first image in the series, and the cells are automatically followed through the series.

o Unique IDs for cells: If the default settings are used, the same cell has different ID number in the different
fluorescence channels. But if the Cell Finder is used or if one of the fluorescence channels is used as a mask
(see image below), each cell has the same unique ID in all the fluorescence channels.

· Select how the results are displayed and saved in Batch Process.
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· Change mode if you simply want to combine and colour images.
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  6.2    Fluorescence image combining and colouring

Combine and colour the images from single and multichannel
fluorescence cell tests with the Fluorescence image combining and
colouring tool.

§ No measurement values are produced, just the combined and
coloured result images. 

§ The tool uses both the phase contrast and fluorescence images at
the same time. 

Fluorescence image combining/colouring procedure

There are two optional ways to do the analysis:

Option 1: 

Step 1: Select the analysis parameters and save them to a Protocol file. 

Step 2: Go to Batch process, open the Protocol from file when asked, and fine tune the parameters if
needed.

Option 2: Go directly to Batch process, and select the parameters on the go. No protocol file is needed.

Make fluorescence image combining/colouring Protocol

§ Open images to the analyser main window using the *.dat file, and open the Fluorescence image combining
and colouring tool from "Tools -> Fluorescence -  image combining and colouring".

§ The preview image that was in the main window is automatically opened to the Fluorescence measurement
tool preview window.

§ Select the measurement parameters step by step. The intermediate results image is always displayed on the
right hand side of the window.

The first four parameter selection steps are identical to the parameter selection in the Fluorescence
intensity measurement tool. See from the Fluorescence intensity measurement topic how the parameters are
selected.

· Select in the last step which type of result images will be saved in the Batch Process, and save the protocol.
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  6.3    Scratch wound measurement

Measure scratch wound areas and closure speed with the scratch wound measurement tool. Measurement is
based on thresholds and selected parameters, and no cell sample image teaching is needed.

Scratch wound measurement procedure

There are two optional ways to do the scratch wound analysis:

Option 1: 

Step 1: Select scratch wound analysis parameters and save them to a Protocol file. 

Step 2: Go to Batch process, open the Protocol from file when asked, and fine tune the parameters if
needed.

Option 2: Go directly to Batch process, and select the scratch wound analysis parameters on the go. No protocol
file is needed.

Make scratch wound analysis Protocol

§ Open images to the analyser main window, and open Scratch wound tool from "Tools -> Scratch wound
measurement".

§ Main window image is automatically opened to Scratch wound analysis preview window.

§ Select analysis parameters. The intermediate image analysis results are displayed, when you click the image
analysis phases.

§ You can change the preview image at any time.

§ Select threshold so that the all the cells and none of the background is thresholded in, and hence colored with
red. Even if cells are now segmented, the background area is finally measured!
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§ Select settings for removing the small unwanted red particles from the measured cell area. You can see that
the two small red areas have disappeared.

§ Select settings for removing the small unwanted grey background gaps from the cell area. You can see that
several gaps have disappeared.
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§ Select how the result images are drawn and which type of result curves will be displayed.

§ Save the scratch wound analysis parameters and result settings to protocol file.
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  6.3.1    Manual tools

The measurement area can be defined manually with the manual tools found from the center top panel. 

§ There is no limit on how many manual areas are added.

§ The result area displayed in picture is a sum of the areas.

§ Area can be measured either manually or automatically, not with both for one time point.  
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  6.4    Area size measurement

Measure cell population areas and growth speed with the area size measurement tool. Measurement is based on
thresholds and selected parameters, and no cell sample image teaching is needed.

Area size measurement procedure

There are two optional ways to do the area size analysis:

Option 1: 

Step 1: Select area size analysis parameters and save them to a Protocol file. 

Step 2: Go to Batch process, open the Protocol from file when asked, and fine tune the parameters if
needed.

Option 2: Go directly to Batch process, and select the area size analysis parameters on the go. No protocol file is
needed.

Make Area size analysis Protocol

§ Open images to the analyser main window, and open area size tool from "Tools -> area size measurement".

§ Main window image is automatically opened to area size analysis preview window.

§ Select analysis parameters. The intermediate image analysis results are displayed, when you click the image
analysis phases.

§ You can change the preview image at any time.

§ Select thresholds so that the all the cells and none of the background is thresholded in. The red, blue and
purple areas are combined after this analysis step.
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§ Select particle size for removing small unwanted particles from the measured cell area. You can see that some
small blue areas from the bottom have disappeared (are not displayed in red in below).

§ Select size of gaps for removing the small unwanted background gaps from the cell area. You can see that
several gaps have disappeared.
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§ Select how the result images are drawn and which result curves will be displayed.

§ Save the area size analysis parameters and result settings to protocol file.
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  6.4.1    Manual tools

The measurement area can be defined manually with the manual tools found from the center top panel. The area
size measurement manual tools are similar to the manual tools for the Scratch wound measurement, see the
topic: Making the other Protocol types -> Scratch wound measurement -> Manual tools.
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  6.5    Tubule and branch point measurement

Analyse angiogenesis images with the tubule and branch point measurement tool. Measurement is based on
thresholds and selected parameters, and no cell sample image teaching is necessarily needed, but it can be
utilized, as described later. The tubule length and the number of different type branch points (different branch
count) are measured. The images should be normal phase contrast images. 

Tubule and branch point measurement procedure

There are two optional ways to do the analysis:

Option 1: 

Step 1: Select the analysis parameters and save them to a Protocol file. 

Step 2: Go to Batch process, open the Protocol from file when asked, and fine tune the parameters if
needed.

Option 2: Go directly to Batch process, and select the analysis parameters on the go. No protocol file is needed.

Make analysis Protocol

§ Open images to the analyser main window, and open tubule and branch point measurement tool from "Tools
-> Tubule and branch point measurement".

§ Main window image is automatically opened to area size analysis preview window.

§ Select analysis parameters. The intermediate image analysis results are displayed when you click the image
analysis phases.

§ You can change the preview image at any time.
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§ Select threshold parameters so that the all the tubules and branch point areas are thresholded in. The
following is targeted: Branch point areas have no holes, tubules are continuous with no cuts, and no single
cells or garbage from the background is colored (but this is secondary target, since they can be fixed also
during later steps). The width of the colored tubule area is not relevant.

§ Single cells in the background can be faultily measured as a small tubule segments. Use these parameters to
remove them from the tubule measurement.
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§ Find the center of each branch point. Branch point is assigned to the center of every disconnected area. Adjust
the red area size so that there is exactly one blue dot in each branch point. If there are too many single branch
points found, some of them are removed automatically in the next analysis stage.
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§ Count how many branches each branch point has. Remove some tubules from the branch count of the branch
point, by defining the minimum distance value, so that the tubules that start too far from center of the branch
point, are not included in the branch count. Branch points that have less than three branches are hidden and
removed from the results.

· Classify tubules using Tubule Classifier protocol. If it is disabled, the total tubule length is measured in any
case, but the tubules will not be classified to different classes. 

o Tubules can be classified to different classes such as thin and thick tubule classes, and false tubules can be
removed from the measurement with the classifier protocol.
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§ Display the final result image.

§ Save the tubule and branch point analysis parameters to protocol file.
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  6.5.1    Manual tools

The tubule and branch point results can be manually edited with these tools in the protocol parameter selection
window, for single images, but they do not change the measurement results when the Batch Process is used!

The image below shows the step 1 (see the left top corner of the image) of the tubule parameter selection, so all
the results displayed in the preview image have been created with the manual tools. The manual tools can be
used in the step 1 and in the final result step 7, where also the automatically created measurement results results
can be edited (erased) with them.

With the manual tools you can:

§ Add tubules. You can define the classes, e.g. thin and thick tubules.

§ Add branch points. You can change the branch point display style.

§ Erase tubules. You can erase the automatically created tubules in the step 7.

§ Erase branch points. You can erase the automatically created branch points in the step 7.



Batch process 

7

102Cell-IQ Analyser User Manual

CM Technologies 9.1.2015

Version MA4.4.0.0



103Cell-IQ Analyser User Manual

CM Technologies 9.1.2015

Version MA4.4.0.0

7    Batch process

Use Batch process for applying the selected image analysis or conversion routines easily for all images from an
entire well plate, with a single run.



104Cell-IQ Analyser User Manual

CM Technologies 9.1.2015

Version MA4.4.0.0

  7.1    Select method and images

Selecting batch process type

Select Batch process in the Analyser main window File menu. Next select batch process type: 

Defining the source and result files and folders

You need to define the source images for the processing, either by a cycle file or by the folder, and a folder for the
results to be saved in. Click Next to continue or Back to change the processing type.

§ The result curves are saved in ACSII format in a *.txt file.
§ File names and subdirectories for the results are automatically created.
§ The result images are normally saved as jpeg images that can also be viewed with other programs.
§ The Analyser converts the curve text files (*.txt) into visible graphs, see more in topic Analysis results. 

With the fluorescence intensity measurement and combining/colouring tools you will also need the images from
the fluorescence channels. But the file selection method is still the same as above, because the program will find
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the fluorescence image folders automatically after you have selected the phase contrast image folder. The
fluorescence image folders are displayed as shown below, and you can disable the program from reading the file
names for some channels using the check boxes.

Select the image positions from the well plate
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Previewing and refining image selection

Preview the number of images selected, and refine the amount of processed data e.g. by selecting only every
second image from series if preferred. Click Next to continue to method special settings, and further to start
analysis run or image conversion.
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  7.2    Count and classify cells

The cell counting and recognition tool counts cells and
classifies them into the user defined classes.

You will need to have the analysis protocol file before you
start the Cell counting and recognition in the Batch
Process tool. The analysis protocol defines the particular
analysis task. See from the other topic how the
measurement parameters are selected and saved to
protocol.

The Batch Process tool can be found from the menu of the
Analyser main window: File -> Batch Process.

§ In the start the analysis Protocol file must be selected, and then program continues to the source and result file
selection.
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§ Adjust class styles and start the analysis run.

Editing class styles
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When image analysis finishes, the results are automatically displayed. Click this to go to topic 'Viewing results'.
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  7.3    Measure fluorescence

Analyse images from single and multichannel fluorescence cell tests
with the Fluorescence intensity measurement tool. 

§ Measurement is based on thresholds and selected parameters,
and no cell sample image teaching is necessarily needed, but it can
be utilized, as later is show. 

§ The fluorescence cell count, area and intensity are measured. 

§ The tool uses both the phase contrast and fluorescence images at
the same time. 

See from another topic how the measurement parameters are selected and saved to protocol.

The Batch Process tool can be found from the menu of the Analyser main window: File -> Batch Process. 

§ Measurement parameters can be opened from Protocol file or selected on the go. After parameters are
selected, click Start from the bottom of the window to run the analysis for the selected images.
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§ If the manual cell selection was selected instead of the automatic, select the cells for measurement from each
image series.
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  7.4    Measuring scratch wound areas

Measure scratch wound areas and closure speed. Measurement is based on thresholds and selected parameters,
and no cell sample image teaching is needed. See from another topic how Scratch wound parameters are
selected and saved to protocol.

§ The Batch Process tool can be found from the menu of the Analyser main window: File -> Batch Process. 

§ Measurement parameters can be opened from Protocol file or selected on the go. After parameters are
selected, click Start from the bottom of the window to run the analysis for the selected images.
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  7.5    Measuring area sizes with threshold tool

Measure cell population areas and growth speed. Measurement is based on thresholds and selected parameters,
and no cell sample image teaching is needed. See from another topic how Area size measurement parameters
are selected and saved to protocol.

§ The Batch Process tool can be found from the menu of the Analyser main window: File -> Batch Process. 

§ Measurement parameters can be opened from Protocol file or selected on the go. After parameters are
selected, click Start from the bottom of the window to run the analysis for the selected images.
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  7.6    Measure tubules and branch points

Analyse angiogenesis images. The images should be normal phase contrast images. The tubule length and the
number of different type branch points (different branch count) are measured. Measurement is based on
thresholds and selected parameters, and no cell sample image teaching is necessarily needed, but it can be
utilized. See from another topic how the measurement parameters are selected and saved to protocol.

The Batch Process tool can be found from the menu of the Analyser main window: File -> Batch Process. 

§ Measurement parameters can be opened from Protocol file or selected on the go. After parameters are
selected, click Start from the bottom of the window to run the analysis for the selected images.
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  7.7    Cell movement tracking

Track cell movements automatically for the image series with this tool. The images should be normal phase
contrast images. Movement trajectory images and rose charts etc. statistics are generated. Cell Finder cell
recognition or cell counting Protocol is required before this tool is started. 

The Batch Process tool can be found from the menu of the Analyser main window: File -> Batch Process. 

Run Cell movement tracking

§ Select Track cell movements and click Next button.

§ Select pre-saved Cell Finder Protocol, and go through the source image selection steps.

§ In the source file selection, select the *.dat file instead of just the source folder, so that cell travel in the results
will be presented in micrometers instead of pixels. Select also the folder where the result data will be saved.
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§ Select the cell tracking and tracking and result settings.

Tracking method. There are two methods available. The v.2. is more recently developed and has better
performance in most cases.
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§ If the manual cell selection was selected instead of the automatic, select the cells for measurement from each
image series.

Cell movement tracking Results

When tracking finishes, the Cell Finder result curve window and the tracking result window (see image below)
open.

§ Select results from different image series to display from the plate map and position list in the right hand side of
the image.

§ The "Trajectory" sheet shows the entire journey the selected cells have traveled in the entire time series.



119Cell-IQ Analyser User Manual

CM Technologies 9.1.2015

Version MA4.4.0.0

§ Also the "Centered trajectory" sheet shows the entire journey the selected cells have traveled in the entire time
series, but here the starting point of each cell is shifted to the center of the image.
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§ The Rose chart sheet shows the direction where the cells moved from start point to the end point in the entire
time series. 

*Note: The rose chart does not tell anything about the cell movement distances, only about the movement
directions. 
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§ The 2D distance graph shows the average movement distance of the fastest cells at each time point
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§ The 3D distance graph: Each entire curve is the tracking result from one time point.
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§ The result *.xml file is saved automatically for each image series to the "2_tracking_results" folder. The first
three rows present average result for the image series, and the latter rows have detailed data of each cell.
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  7.8    Stitching grids
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  7.9    Exporting videos

Select the playback speed and the quality for the videos. To add the caption texts and time stamps in the videos
click the Captions and logos button, see more in Movie Maker.

§ View cell videos with any media player application that supports the .wmv file format. 
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  7.10    Combine and colour images

Combine and colour the images from single and multichannel
fluorescence cell tests with the Fluorescence image combining and
colouring tool.

§ No measurement result values are produced, just the combined
and coloured result images. 

§ The tool uses both the phase contrast and fluorescence images at
the same time. 

See from another topic how the measurement parameters are selected and saved to protocol.

The Batch Process tool can be found from the menu of the Analyser main window: File -> Batch Process. 

§ Measurement parameters can be opened from Protocol file or selected on the go. After parameters are
selected, click Start from the bottom of the window to run the analysis for the selected images.
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  7.11    Image processing operations
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  7.11.1    Resize

Change the pixel dimensions of images

1. Select Resize

2. Define the dimensions of the resized images. Fill in the dimensions in pixels or give a percentage of the
original.Click Show image preview to preview a resized image.

3. Select the interpolation method from the drop menu. You can compare the original image and the result
with different interpolation method in the preview window by switching from Original image to Result image.

4. Click Next.
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  7.11.2    Region of interest

Take a custom size region from images

1. Select Take region of interest (ROI)

2. Click Show image preview and open sample image to preview ROI, which is indicated with a white dotted
rectangle in the preview image. 

3. Define the dimensions of ROI and give the coordinates in the image, or select Draw ROI and draw it with
mouse on the preview image. Click the Center button to set the ROI to the center of the image.

4. Click Next.
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  7.11.3    Brighten/Darken

Brighten/darken: Change the brightness of images

1. Select Brighten/Darken

2. Click Show image preview and open a sample image to preview image brightness. You can compare the
original and the result image in the preview window by switching from Original image to Result image.

3. Select brightening method. Adjust brightness by percentage by selecting Brighten/Darken image or select
Fixed average gray level value and fill in the desired value.

4. Click Next.
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  7.11.4    Grey level threshold

Limit the grey level range or produce a binary image

1. Select Grey level threshold

2. The upper and lower threshold limits are set between 0-255 and pixels that have values outside these limits
are set to zero. Click Show image preview and browse for a sample image to compare the original image
with the result image. 

3. The grey value between these limits in the output image can be set to 255 (binary image) or the original
grey level can be maintained. 

4. Click Next.
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  7.11.5    Background correction

Background correction: Even out background trend in image

1.Select Make background correction

2. Select background image source

3. Select the correction method.

4.  Click Next.

Selecting background image source:

§  Auto-find for each source image

§  Auto-find from the sample image to be used to correct all images. Click Show image preview and Open
sample image  to define the sample image. You can choose to view the sample image, the background
image or the result image in the preview window.

§ Use loaded background image. Click Load background image and open the file.

Select one of the background correction methods:

§ Flatten to a certain gray level. The image is first divided with background image and then multiplied to a
fixed grey level.

§ Divide with background image

§ Subtract the background image
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Example: Background corrected images stitched to a grid
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  7.11.6    Remove image series XY judder 

Remove image series XY judder: Align images from series so that images do not appear to jump when
video is played

1. Select Remove image series XY judder

2. Select judder fixing parameter that defines the maximum image shift that is fixed. Smaller parameter
makes the fixing faster and bigger correspondingly slower. The result images have the same size as the
source images, and when the image is shifted, the blank space is filled by mirroring the image edges.
Preserving the original image size is beneficial if image grid is later stitched together.

4. Click Next.
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8    Analysis results

View, present and extract analysis results

§ Result curves

§ Graph functions

§ Saving graphs

§ Curve table

§ Segmented result images

§ Export results into Excel

§ Extract cell count curves
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  8.1    Viewing results

Result curves

§ Click the Show result curve window- button in the Analyser main window to view the cell count curves of
analysed data. The results window also opens automatically when analysis is finished.

§ When the Cell Finder tool is used, the white dotted curve is the total cell number and the colored curves are cell
numbers in each class of the protocol. The color codes are displayed next to the graph. 

§ The line colors in graphs can be customized, click Options menu to select custom line colors and graph
background style with or without color gradient. 

Segmented result images
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Graph functions

Highlight time points where cell count has increased or decreased a given number, and smoothen curves.

§ You can use these controls for showing the LD50 point in curve.
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Compare different wells or well groups to each others, by grouping the wells from the well plate image.
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Edit e.g. curve graph titles and axes scales from the Graph settings window.

* Note: This window also includes the Standard Deviation display option for the combined curves.
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Saving graph image

Curve table

Click Curve table in the Show menu above the graph to view all result curves of the well plate. The curve table is
a good tool in comparing the result curves in the wellplate. Select the position in the well or select all positions
from the drop menu. You can save a jpg snap shot of the curve table.
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  8.2    Exporting results

Exporting results into Excel

Select Export curve data: All positions. Note that there's a limitation of 256 columns on one sheet in Excel. The
results might have to saved in many separate xml files, which can be very inconvenient. That's why it's
recommended to use the selected positions option to avoid exceeding the limit.

Extracting curve files

Extract the *.txt files by selecting Export: Copy original curve file(s). The curve files are extracted from the
result folders leaving out the result images. The subfolders and file names are created automatically.

  STRUCTURE OF THE EXPORTED XML FILE
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9    Manual measurement tools

In addition to the automatic measurement tools mentioned earlier in this manual, there are some manual

measurement tools available:

§ Manual cell tracking: Produce manually the similar results as in the automatic cell movement tracking

§ Manual cell lineage: Track cells through cell divisions, and generate family trees and movement vector

images

§ Manual area measurement: Measure cell brightness and the area based on the threshold
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  9.1    Manual cell tracking

Track cells and generate movement vector images and rose charts
etc. statistics. The tool is completely manual - the mouse left click
adds the new cell positions to the new time points. 

The results are displayed and saved in the same format as in the
automatic cell tracking measurement.

Manual cell tracking:

· Open images to the Analyser main window. Using *.dat file for image opening is recommended.

· Open Manual cell tracking tool from "Tools -> Manual cell tracking". The Manual cell tracking tool window
opens.

· Select well position from the right side (if plate map visible) and scroll to interesting time point in image series
from the scroll bar in the bottom.

· Track cell: Select the cell of interest from the image and track it by mouse left click. The tracking tool adds new
time points to cell tree automatically.

· Track different cell: Press Add cell family–button (see image below), and left click any cell to start tracking.

· Continue tracking third cell, after tracking some other cell in between: Click #3 -label from the family tree
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diagram. The program drives to the correct time point where you should add the next new position for the cell.

· Display result graphics and full journey image from the Show results –button. The results are displayed and
saved in the same format as in the automatic cell tracking.

· Save results from the Save results –button. You can open the saved results later from the Open result images
-button (Analyser main window File-menu) the same way as the results from the Automatic  Tracking.

· You can edit existing cell tracks from the different buttons in the Manual cell lineage tool, as shown in the image
below.
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Visualization settings

· The manual cell tracking has similar visualization settings (image below) as the automatic Cell tracking tool.

· Cell recognition classes: You can give cell a different recognition class in each time point, even if there is not
automatic cell recognition in this tool, see image in below.
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  9.1.1    Autocomplete Tracking

Auto complete tracking automatically in the end part of the image series where the cell does not yet have
coordinates. 

§ The coordinates can be missing if user has not finished manual tracking till the end of the series.

§ The coordinates can be missing if user has deleted time points after finding them faulty, and continued manual
tracking over the time points that maybe caused problems for automatic tracking.
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  9.1.2    Edit Tracking results

You can complete or edit the old tracking results in the tracking Results Editing -window. Then you can save the
fixed results to the new result folder.

Edit  tracking Results:

Open the tracking Results Editing -window, as shown in the image below. 

§ Start by opening the tracking result curves of the entire well plate. 

§ Results Editing -window will get a copy of the tracking results for editing - the tracking result window will keep
the old values unmodified until they are later actively refreshed by the user.

§ Tracking Results Editing -window will request the location of the original, unmodified source images. They are
needed so that the dots and trajectories of the modified cell tracking result can be drawn to them, and also if the
automatic cell tracking is utilized in the Results Editing. 

§ The tracking results Editing window is identical to the Manual cell tracking tool.
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  9.2    Manual cell lineage

Track cells through cell divisions, and generate family trees and
movement vector images. The tool is completely manual - the mouse
left click adds the new cell positions to the new time points. 

The results are displayed and saved in the same format as in the
automatic cell lineage measurement.

Make manual cell lineage measurements:

· Open images to the Analyser main window. Using *.dat file for image opening is recommended.

· Open Manual cell lineage tool from "Tools -> Manual cell lineage". The Manual cell lineage tool window opens.

· Select well position from the right side (if plate map visible) and scroll to interesting time point in image series
from the scroll bar in the bottom.

· Track cell: Select the cell of interest from the image and track it by mouse left click. The lineage tool adds new
time points to family tree automatically.

· Track different cell: Press Add cell family–button (see image below), and left click any cell to start tracking.

· Add cell division: Press Add division –button (see image above), and left click the first daughter cell in image.
Then you can continue to click and add more time points for the first daughter. 

· Track the second daughter: Press #1.2 -label from the family tree diagram. The program drives to the correct
time point where you should add the position for the second daughter. Left click image and continue to track the
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second daughter. You can jump back and forth between the two daughters, by clicking the cell IDs in the tree
view.

· Display result tree view and full journey image from the Show results –button. The results are displayed and
saved in the same format as in the automatic cell lineage measurement.

· Save results from the Save results –button. You can open the saved results later from the Open result images
-button (Analyser main window File-menu) the same way as the results from the Automatic Lineage
measurement.

· You can edit existing cell families from the different buttons in the Manual cell lineage tool, as shown in the
image below.

Visualization settings

· The manual cell lineage has similar visualization settings (image below) as the automatic Cell lineage tool.

· Cell recognition classes: You can give cell a different recognition class in each time point, even if there is not
automatic cell recognition in this tool, see image in below.
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  9.2.1    Edit Lineage results

You can fix the possible errors in the lineage results in the Lineage Results Editing -window. Then you can save
the fixed results to the new result folder.

Edit  Lineage Results:

Open the Lineage Results Editing -window, as shown in the image below. 

§ Start by opening the Lineage result curves of the entire well plate. 

§ Results Editing -window will get a copy of the Lineage results for editing - the Lineage result (Tree/Trajectory)
window will keep the old values unmodified until they are later actively refreshed by the user.

§ Lineage Results Editing -window will request the location of the original, unmodified source images. They are
needed so that the dots and trajectories of the modified cell tracking result can be drawn to them, and also if the
automatic cell tracking is utilized in the Results Editing. 

§ The Lineage results Editing window is identical to the Manual cell lineage tool.
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  9.3    Manual area measurement

Measure intensities in e.g. fluorescence images

 

Area measurement settings: Round area

Area measurement settings: custom area
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Custom shape for each measurement

Grey level values
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Display settings

Viewing measurements
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Editing line color and width

Saving area measurements

Saving image(s)

Export measurement(s) 
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Area measurement result file

The measurements are exported into an *.xml file that can be opened with Excel. 

Histogram tool
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10    Contact

CM Technologies Ltd.

§ Adress: Biokatu 12, 33520 Tampere, Finland

§ Phone: +358 10 759 5900

§ Fax: +358 10 759 5930

§ Email: info@c-mtechnologies.com

§ URL: www.c-mtechnologies.com

mailto:info@c-mtechnologies.com
http://www.chipmantech.com
http://www.c-mtechnologies.com
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